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Single Sign-On
Single sign-on (SSO) is an authentication and authorization process. (Authentication proves that you are the
user you say that you are, and authorization verifies that you are allowed to do what you want to do.) SSO
allows you to sign in to one application and then securely access other authorized applications without a
prompt to resupply user credentials. SSO permits Cisco supervisors or agents to sign on only once with a
username and password. Supervisors and agents gain access to all of their Cisco browser-based applications
and services within a single browser instance. By using SSO, Cisco administrators can manage all users from
a common user directory and enforce password policies for all users consistently.

Before enabling SSO in Unified CCE, ensure to sign in to the Cisco Unified Intelligence Center OAMP
interface and perform the Unified CCE User Integration operation (Cluster Configuration > UCCE User
Integration) once manually to import the Supervisors with the required roles.

Note

SSO is an optional feature whose implementation requires you to enable the HTTPS protocol across the
enterprise solution.

You can implement single sign-on in one of these modes:

• SSO - Enable all agents and supervisors in the deployment for SSO.
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• Hybrid - Enable agents and supervisors selectively in the deployment for SSO. Hybrid mode allows you
to phase in the migration of agents from a non-SSO deployment to an SSO deployment and enable SSO
for local PGs. Hybrid mode is useful if you have third-party applications that don't support SSO, and
some agents and supervisors must be SSO-disabled to sign in to those applications.

• Non-SSO - Continue to use existing Active Directory-based and local authentication, without SSO.

SSO uses Security AssertionMarkup Language (SAML) to exchange authentication and authorization details
between an identity provider (IdP) and an identity service (IdS). The IdP authenticates based on user credentials,
and the IdS provides authorization between the IdP and applications. The IdP issues SAML assertions, which
are packages of security information transferred from the IdP to the service provider for user authentication.
Each assertion is an XML document that contains trusted statements about a subject including, for example,
username and privileges. SAML assertions are digitally signed to ensure their authenticity.

The IdS generates an authentication request (also known as a SAML request) and directs it to the IdP. SAML
does not specify the method of authentication at the IdP. It may use a username and password or other form
of authentication, including multi-factor authentication. A directory service such as LDAP or AD that allows
you to sign in with a username and a password is a typical source of authentication tokens at an IdP.

Prerequisites

The Identity Provider must support Security Assertion Markup Language (SAML) 2.0. See the Compatibility
Matrix for your solution at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-device-support-tables-list.html for details.

Contact Center Enterprise Reference Design Support for Single Sign-On
Unified CCE supports single sign-on for the following reference designs:

• 2000 Agents

• 4000 Agents

• 12000 Agents (maximum of 4000 active SSO agents)

• Contact Director (Maximum of 8000 active agents, 4000 on each of two target Unified CCE deployment
instances. Each target system must include a dedicated Cisco IdS deployment.)

Coresidency of Cisco Identity Service by Reference Design
Unified CCEReference Design

Cisco IdS is coresident with Unified Intelligence Center and Live Data on a single
VM.

2000 Agent

Standalone Cisco IdS VM4000 Agent

Standalone Cisco IdS VM12000 Agent

Single Sign-On Support and Limitations
Note the following points related to SSO support:
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• To support SSO, enable the HTTPS protocol across the enterprise solution.

• SSO supports agents and supervisors only. SSO support is not available for administrators in this release.

• In the 12,000 Agent Reference Design, a maximum of 4,000 agents can use SSO at one time.

• SSO supports multiple domains with federated trusts.

• SSO supports only contact center enterprise peripherals.

Note the following limitations related to SSO support:

• SSO does not support remote PGs. To support SSO in a global topology, locate the PGs at the main site.

• SSO support is not available for third-party Automatic Call Distributors (ACDs), the Unified CCE System
PG, the Media Routing (MR) PG, or the Voice Response Unit (VRU) PG.

• The SSO feature does not support Cisco Finesse IP Phone Agent (FIPPA).

Allowed Operations by Node Type
The Cisco IdS cluster contains a publisher and a subscriber node. A publisher node can perform any
configuration and access token operations. The operations that a subscriber node can perform depends on
whether the publisher is connected to the cluster.

This table lists which operations each type of node can perform.

Table 1: Single Sign-On Allowed Operations

Allowed on SubscriberAllowed on PublisherOperation

NeverAlwaysUpload IdP metadata

NeverAlwaysDownload SAML SP metadata

NeverAlwaysRegenerate SAML Certificate

NeverAlwaysRegenerate Token
Encryption/Signing Key

Only when publisher is connectedAlwaysUpdate AuthCode/Token Expiry

Only when publisher is connectedAlwaysEnable/Disable Token Encryption

Only when publisher is connectedAlwaysAdd/Update/Delete Cisco IdS client
configuration

AlwaysAlwaysViewCisco IdS client configuration

AlwaysAlwaysView Cisco IdS status

AlwaysAlwaysSet Troubleshooting Log Level

AlwaysAlwaysSet Remote Syslog server
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Single Sign-On Log Out
For a complete logout from all applications, sign out of the applications and close the browser window. In a
Windows desktop, log out of the Windows account. In a Mac desktop, quit the browser application.

Users enabled for single sign-on are at risk of having their accounts misused by others if the browser is not
closed completely. If the browser is left open, a different user can access the application from the browser
page without entering credentials.

Note

Single Sign-On Configuration Flow

Synchronize the time in Cisco IdS and IdP for SSO to work effectively. It is recommended that the Cisco IdS
and IdP are time-synchronized using NTP Server.

Note

1. Install the appropriate release of the CCE solution. For more information, see Cisco Unified Contact
Center Enterprise Installation and Upgrade Guide at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/products-installation-guides-list.html

2. Install the Cisco Identity Service (Cisco IdS). For more information, see Cisco Unified Contact Center
Enterprise Installation andUpgradeGuide at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-installation-guides-list.html

3. Configure an Identity Provider (IdP).

4. Configure System Inventory.

5. Configure the Cisco IdS.

6. Register and test SSO-compatible components with the Cisco IdS.

7. Choose the SSO mode.

8. Enable multiple users at once for SSO by using the SSO migration tool, or enable users one at time by
using the configuration tools.

Related Topics
Install Cisco Identity Service Standalone Deployment, on page 5
Configure the Cisco Identity Service, on page 24
Configure an Identity Provider (IdP), on page 16
Set up the System Inventory for Single Sign-On, on page 21
Register Components and Set Single Sign-On Mode, on page 26
Migrate Agents and Supervisors to Single Sign-On Accounts, on page 29
Single Sign-On Migration and the Configuration Manager, on page 31
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Single Sign-On Installation
Complete the installation or upgrade procedure. For more information, see Cisco Unified Contact Center
Enterprise Installation and Upgrade Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-installation-guides-list.html.

Installation Task Flow for Cisco Identity Service
You can install Cisco Identity Service as a standalone or coresident deployment.

SeeTask

Install Cisco Identity Service Standalone
Deployment, on page 5

or

Install Coresident Deployment (Cisco
Unified Intelligence Center with Live Data
and IdS), on page 12

Install Cisco Identity Service Standalone Deployment (4000,
8000, 12000 Agent Deployment)

or

Install Coresident Deployment (2000 Agent Deployment)

Install Cisco Identity Service Standalone Deployment
Follow this sequence of tasks to install the Cisco Identity Service (Cisco IdS) standalone deployment.

TaskSequence

Verify that you created a separate virtual machine for the IdS publisher node and the IdS
subscriber node. See Set Up Virtual Machines, on page 6.

1

Install IdS publisher node. See Install Publishers/Primary Nodes of VOS-Based Contact
Center Applications, on page 12

2

Set IdS subscriber node. See Set IdS Subscriber Node, on page 83

Install IdS subscriber node. See Install Subscribers/Secondary Nodes of VOS-Based Contact
Center Applications, on page 14

4

Upgrade VMware Tools. See Install VMware Tools for VOS, on page 115

Set Deployment Type in Unified CCE Administration Configuration
Before you install or upgrade, you must set the deployment type.

Procedure

Step 1 Navigate to Unified CCE Administration > System > Deployment.
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Step 2 Select your deployment from the drop-down menu and click Next.

Set Up Virtual Machines

Verify Datastores

Before you install the VMs, verify that the datastore is in place. The type of datastore depends on the type of
server on which you deploy the VMs. For example, UCS-B servers use a SAN datastore and UCS-C servers
use DAS datastores.

For more information, see the VMware documentation at https://www.vmware.com/support/pubs/.

For more information, see Virtualization for Unified Contact Center Enterprise at http://docwiki.cisco.com/
wiki/Virtualization_for_Unified_CCE.

Download Unified CCE OVA Files

The Unified CCE Open Virtualization Format (OVA) files define the basic structure of the corresponding
VMs that are created. The structure definition includes the CPU, RAM, disk space, reservation for CPU, and
reservation for memory.

Before you begin

You must have a valid service contract associated with your Cisco.com profile.

Procedure

Step 1 Go to the Unified CCE Download Software page on Cisco.com.
Step 2 Click Download to download and save the appropriate OVA file to your local hard drive. When you create

VMs, you select the OVA required for the application.

Create Virtual Machines from OVA Files

To create virtual machines (VMs) from the OVA files, complete the following procedure.

ECE requires a second virtual hard drive on its VM. The OVA creates one virtual hard drive. Create a second
hard drive of an appropriate size for your solution requirements.

Note

Procedure

Step 1 Select the Host in the vSphere client.
Step 2 Choose File > Deploy OVF Template.
Step 3 Browse to the location on your local drive where you stored the OVA. Click Open to select the file. Click

Next.
Step 4 Click Next at the OVF Template Details page.
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Step 5 Enter the virtual machine name. It cannot contain spaces or special characters. Enter a maximum of 32
characters. Click Next.

Step 6 On the Name and Location page, enter a name of your choice in the Name field. Click Next.

After the VM is created, you cannot rename it.Important

Step 7 On the Deployment Configuration page, select the applicable configuration from the drop-down list. Click
Next.

Step 8 Choose a data store on which to deploy the new virtual machine. Click Next.

Some deployments require two data stores.Note

Step 9 On the Disk Format page, choose Thick provisioned Eager Zeroed format for the virtual disk format.
Click Next.

Thick provisioned Lazy Zero is also supported, but Thin provisioned is not supported.Note

Step 10 Confirm that the Network Mapping page is correct:
a) Public network adapter to Public network
b) Private network adapter to Private network

For some deployments, only one network interface is available.Note

Step 11 Click Finish.
Step 12 At the Successfully Completed message, click Close.

For more information, see Virtualization for Unified Contact Center Enterprise at
http://docwiki.cisco.com/wiki/Virtualization_for_Unified_CCE.

Note

Install Publishers/Primary Nodes of VOS-Based Contact Center Applications

Before you begin

DNS Configuration is mandatory for installation of Cisco Unified Communications Manager, Cisco Unified
Intelligence Center, Cisco Finesse and Cisco Identity Service (IdS). To configure DNS, add the VMs to the
forward and reverse lookups of the DNS.

Procedure

Step 1 Create a virtual machine for your VOS-based contact center application using the OVA.
Step 2 Mount the ISO image for the software to the virtual machine.
Step 3 Select the virtual machine, power it on, and open the console.
Step 4 Follow the Install wizard, making selections as follows:

a) In the Disk Found screen, click OK to begin the verification of the media integrity.
b) In the Success screen, select OK.
c) In the Product Deployment Selection screen:
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• For the Progger (Lab only) or 2000 agent reference design, choose the coresident deployment
option Cisco Unified Intelligence Center with Live Data and IdS, and then select OK. The
Cisco Unified Intelligence Center with Live Data and IdS option installs Cisco Unified
Intelligence Center with Live Data and Cisco Identity Service (IdS) on the same server.

• For all other deployments, select one of the standalone install options. For example, select Cisco
Unified Intelligence Center, Live Data, or Cisco Identity Service (IdS). Then select OK.

d) In the Proceed with Install screen, select Yes.
e) In the Platform Installation Wizard screen, select Proceed.
f) In the Apply Patch screen, select No.
g) In the Basic Install screen, select Continue.
h) In the Timezone Configuration screen, use the down arrow to choose the local time zone that most

closely matches where your server is located. Select OK.

For Live Data servers, use the same timezone for all the nodes.Note

i) In the Auto Negotiation Configuration screen, select Continue.
j) In theMTU Configuration screen, select No to keep the default setting for Maximum Transmission

Units.
k) In the DHCP Configuration screen, select No.
l) In the Static Network Configuration screen, enter static configuration values. Select OK.
m) In the DNS Client Configuration screen, click Yes to enable DNS client.
n) Enter your DNS client configuration. Select OK.
o) In the Administrator Login Configuration screen, enter the Platform administration username. Enter

and confirm the password for the administrator. Select OK.
p) In theCertificate Information screen, enter data to create your Certificate Signing Request: Organization,

Unit, Location, State, and Country. Select OK.
q) In the First Node Configuration screen, select Yes.
r) In the Network Time Protocol Client Configuration screen, enter a valid NTP server IP address and

select OK.
s) In the Security Configuration screen, enter the security password and select OK.
t) In the SMTP Host Configuration screen, select No.
u) In the Application User Configuration screen, enter the application username. Enter, and confirm the

application user password. Select OK.
v) In the Platform Configuration Confirmation screen, select OK. The installation begins and runs

unattended.

• There is a reboot in the middle of the installation.

• The installation ends at a sign-in prompt.

Step 5 Unmount the ISO image.

Set IdS Subscriber Node
Youmust provide the publisher node the address of the subscriber node. You do this with the set ids subscriber
command.
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Procedure

Step 1 Log in to your publisher IdS node.
Step 2 Run the following command to set the subscriber node:

set ids subscriber name
name

Specifies the hostname or ip address of the IdS subscriber node address.

What to do next

You can use these Cisco IdS CLI commands only in an IdS standalone deployment. You run these commands
on the IdS publisher node.

Required Minimum Privilege Level: Ordinary

Use this command to show IdS subscriber node information.

show ids subscriber

There are no required parameters.

Required Minimum Privilege Level: Advanced

Use this command to unset IdS subscriber node configuration.

unset ids subscriber

There are no required parameters.

Identity Service CLI Commands
You can use these Cisco IdS CLI commands only in an IdS standalone deployment. You run these commands
on the IdS publisher node.

set ids subscriber

Required Minimum Privilege Level: Advanced

Use this command to set the single sign-on Identity Service (IdS) subscriber node address .

Command Syntax
set ids subscriber name
name

Specifies the hostname or ip address of the IdS subscriber node address.

unset ids subscriber

Required Minimum Privilege Level: Advanced

Use this command to unset IdS subscriber node configuration.

unset ids subscriber
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There are no required parameters.

show ids subscriber

Required Minimum Privilege Level: Ordinary

Use this command to show IdS subscriber node information.

show ids subscriber

There are no required parameters.

Install Subscribers/Secondary Nodes of VOS-Based Contact Center Applications

This task is required for installation of the subscriber/secondary nodes of the three VOS-based contact center
applications: Cisco Finesse, Cisco Unified Communications Manager, and Cisco Unified Intelligence Center.

Note

Before you begin

DNS Configuration is mandatory for installation of Cisco Unified Communications Manager, Cisco Unified
Intelligence Center, and Cisco Finesse. To configure DNS, add the VMs to the forward and reverse lookups
of the DNS.

Before you install the subscriber/secondary nodes, youmust install the publisher/primary nodes and configure
the clusters.

Procedure

Step 1 Create a virtual machine for your VOS-based contact center application using the OVA.
Step 2 Mount the ISO image for the software to the virtual machine.
Step 3 Select the virtual machine and power it on, and open the console.
Step 4 Follow the Install wizard, making selections as follows:

a) In the Disk Found screen, click OK to begin the verification of the media integrity.
b) In the Success screen, select OK.
c) In the Product Deployment Selection screen:

• For the Progger (Lab only) or 2000 agent reference design, choose the coresident deployment option
Cisco Unified Intelligence Center with Live Data and IdS, and then selectOK. TheCisco Unified
Intelligence Center with Live Data and IdS option installs Cisco Unified Intelligence Center, Live
Data, and Cisco Identity Service (IdS) on the same server.

• For all other deployments, select one of the standalone install options. For example, select Cisco
Unified Intelligence Center, Live Data, or Cisco Identity Service (IdS). Then select OK.

Step 5 Follow the Install wizard, making selections as follows:
a) In the Proceed with Install screen, select Yes.
b) In the Platform Installation Wizard screen, select Proceed.
c) In the Apply Patch screen, select No.
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d) In the Basic Install screen, select Continue.
e) In the Timezone Configuration screen, use the down arrow to choose the local time zone that most

closely matches where your server is located. Select OK.

For Live Data servers, use the same timezone for all the nodes.Note

f) In the Auto Negotiation Configuration screen, select Continue.
g) In theMTU Configuration screen, select No to keep the default setting for Maximum Transmission

Units.
h) In the DHCP Configuration screen, select No.
i) In the Static Network Configuration screen, enter static configuration values. Select OK.
j) In the DNS Client Configuration screen, click Yes to enable DNS client.
k) In the Administrator Login Configuration screen, enter the Platform administration username. Enter

and confirm the password for the administrator. Select OK.
l) In theCertificate Information screen, enter data to create your Certificate Signing Request: Organization,

Unit, Location, State, and Country. Select OK.
m) In the First Node Configuration screen, select No.
n) In the warning screen, select OK.
o) In the Network Connectivity Test Configuration screen, select No.
p) In the First Node Access Configuration screen, enter the host name and IP address of the first node.

Enter and confirm the security password. Select OK.
q) In the SMTP Host Configuration screen, select No.
r) In the Platform Configuration Confirmation screen, select OK. The installation begins and runs

unattended.

• There is a reboot in the middle of the installation.

• The installation ends at a sign-in prompt.

Step 6 Unmount the ISO image.

Install VMware Tools for VOS
To install or upgrade VMware Tools using VOS, perform the following steps:

Procedure

Step 1 Ensure that your virtual machine is powered on.
Step 2 Right-click the VM menu. Select Guest > Install / Upgrade VMware tools .
Step 3 Choose the interactive tools update and press OK.
Step 4 Open the console and log in at the command prompt.
Step 5 Enter the command utils vmtools refresh and confirm.

The server automatically reboots twice.
Step 6 After reboot, check the Summary tab for the VM to verify that the VMware Tools version is current. If it is

not current, reboot the VM and check the version again.
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The process takes a few minutes. After the process completes, the tools are listed as Running (Current) on
the VM's Summary tab in vSphere.

Install Coresident Deployment (Cisco Unified Intelligence Center with Live
Data and IdS)

Follow this sequence of tasks to install the coresident deployment (Cisco Unified Intelligence Center with
Live Data and IdS).

TaskSequence

Set Deployment Type in Unified CCE Administration Configuration, on page 121

Install IdS publisher node. See Install Publishers/Primary Nodes of VOS-Based Contact
Center Applications, on page 12

2

Install IdS subscriber node. See Install Subscribers/Secondary Nodes of VOS-Based Contact
Center Applications, on page 14

3

Add Coresident (Cisco Unified Intelligence Center with Live Data and IdS) Machine Type
to the System Inventory, on page 15

4

Upgrade VMware Tools. See Install VMware Tools, on page 165

Set Deployment Type in Unified CCE Administration Configuration
Before you install or upgrade IdS you must set the deployment type.

Procedure

Step 1 Navigate to Unified CCE Administration > System > Deployment.
Step 2 Select your deployment from the drop-down menu and click Next.

Install Publishers/Primary Nodes of VOS-Based Contact Center Applications

Before you begin

DNS Configuration is mandatory for installation of Cisco Unified Communications Manager, Cisco Unified
Intelligence Center, Cisco Finesse and Cisco Identity Service (IdS). To configure DNS, add the VMs to the
forward and reverse lookups of the DNS.

Procedure

Step 1 Create a virtual machine for your VOS-based contact center application using the OVA.
Step 2 Mount the ISO image for the software to the virtual machine.
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Step 3 Select the virtual machine, power it on, and open the console.
Step 4 Follow the Install wizard, making selections as follows:

a) In the Disk Found screen, click OK to begin the verification of the media integrity.
b) In the Success screen, select OK.
c) In the Product Deployment Selection screen:

• For the Progger (Lab only) or 2000 agent reference design, choose the coresident deployment
option Cisco Unified Intelligence Center with Live Data and IdS, and then select OK. The
Cisco Unified Intelligence Center with Live Data and IdS option installs Cisco Unified
Intelligence Center with Live Data and Cisco Identity Service (IdS) on the same server.

• For all other deployments, select one of the standalone install options. For example, select Cisco
Unified Intelligence Center, Live Data, or Cisco Identity Service (IdS). Then select OK.

d) In the Proceed with Install screen, select Yes.
e) In the Platform Installation Wizard screen, select Proceed.
f) In the Apply Patch screen, select No.
g) In the Basic Install screen, select Continue.
h) In the Timezone Configuration screen, use the down arrow to choose the local time zone that most

closely matches where your server is located. Select OK.

For Live Data servers, use the same timezone for all the nodes.Note

i) In the Auto Negotiation Configuration screen, select Continue.
j) In theMTU Configuration screen, select No to keep the default setting for Maximum Transmission

Units.
k) In the DHCP Configuration screen, select No.
l) In the Static Network Configuration screen, enter static configuration values. Select OK.
m) In the DNS Client Configuration screen, click Yes to enable DNS client.
n) Enter your DNS client configuration. Select OK.
o) In the Administrator Login Configuration screen, enter the Platform administration username. Enter

and confirm the password for the administrator. Select OK.
p) In theCertificate Information screen, enter data to create your Certificate Signing Request: Organization,

Unit, Location, State, and Country. Select OK.
q) In the First Node Configuration screen, select Yes.
r) In the Network Time Protocol Client Configuration screen, enter a valid NTP server IP address and

select OK.
s) In the Security Configuration screen, enter the security password and select OK.
t) In the SMTP Host Configuration screen, select No.
u) In the Application User Configuration screen, enter the application username. Enter, and confirm the

application user password. Select OK.
v) In the Platform Configuration Confirmation screen, select OK. The installation begins and runs

unattended.

• There is a reboot in the middle of the installation.

• The installation ends at a sign-in prompt.

Step 5 Unmount the ISO image.
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Install Subscribers/Secondary Nodes of VOS-Based Contact Center Applications

This task is required for installation of the subscriber/secondary nodes of the three VOS-based contact center
applications: Cisco Finesse, Cisco Unified Communications Manager, and Cisco Unified Intelligence Center.

Note

Before you begin

DNS Configuration is mandatory for installation of Cisco Unified Communications Manager, Cisco Unified
Intelligence Center, and Cisco Finesse. To configure DNS, add the VMs to the forward and reverse lookups
of the DNS.

Before you install the subscriber/secondary nodes, youmust install the publisher/primary nodes and configure
the clusters.

Procedure

Step 1 Create a virtual machine for your VOS-based contact center application using the OVA.
Step 2 Mount the ISO image for the software to the virtual machine.
Step 3 Select the virtual machine and power it on, and open the console.
Step 4 Follow the Install wizard, making selections as follows:

a) In the Disk Found screen, click OK to begin the verification of the media integrity.
b) In the Success screen, select OK.
c) In the Product Deployment Selection screen:

• For the Progger (Lab only) or 2000 agent reference design, choose the coresident deployment option
Cisco Unified Intelligence Center with Live Data and IdS, and then selectOK. TheCisco Unified
Intelligence Center with Live Data and IdS option installs Cisco Unified Intelligence Center, Live
Data, and Cisco Identity Service (IdS) on the same server.

• For all other deployments, select one of the standalone install options. For example, select Cisco
Unified Intelligence Center, Live Data, or Cisco Identity Service (IdS). Then select OK.

Step 5 Follow the Install wizard, making selections as follows:
a) In the Proceed with Install screen, select Yes.
b) In the Platform Installation Wizard screen, select Proceed.
c) In the Apply Patch screen, select No.
d) In the Basic Install screen, select Continue.
e) In the Timezone Configuration screen, use the down arrow to choose the local time zone that most

closely matches where your server is located. Select OK.

For Live Data servers, use the same timezone for all the nodes.Note

f) In the Auto Negotiation Configuration screen, select Continue.
g) In theMTU Configuration screen, select No to keep the default setting for Maximum Transmission

Units.

Single Sign-On
14

Single Sign-On
Install Subscribers/Secondary Nodes of VOS-Based Contact Center Applications



h) In the DHCP Configuration screen, select No.
i) In the Static Network Configuration screen, enter static configuration values. Select OK.
j) In the DNS Client Configuration screen, click Yes to enable DNS client.
k) In the Administrator Login Configuration screen, enter the Platform administration username. Enter

and confirm the password for the administrator. Select OK.
l) In theCertificate Information screen, enter data to create your Certificate Signing Request: Organization,

Unit, Location, State, and Country. Select OK.
m) In the First Node Configuration screen, select No.
n) In the warning screen, select OK.
o) In the Network Connectivity Test Configuration screen, select No.
p) In the First Node Access Configuration screen, enter the host name and IP address of the first node.

Enter and confirm the security password. Select OK.
q) In the SMTP Host Configuration screen, select No.
r) In the Platform Configuration Confirmation screen, select OK. The installation begins and runs

unattended.

• There is a reboot in the middle of the installation.

• The installation ends at a sign-in prompt.

Step 6 Unmount the ISO image.

Add Coresident (Cisco Unified Intelligence Center with Live Data and IdS) Machine Type to the
System Inventory

Procedure

Step 1 In Unified CCE Administration, navigate to System > Deployment.
Step 2 Add the new machine to the System Inventory:

a) Click Add.

The Add Machine popup window opens.

b) From the Type drop-down menu, select the following machine type:

CUIC_LD_IdS Publisher, for the coresident Unified Intelligence Center, Live Data, and Identity Service
machine available in the 2000 agent reference design.

c) In the Hostname field, enter the FQDN, hostname, or IP address of the machine.

The system attempts to convert the value you enter to FQDN.

d) Enter the machine's Administration credentials.
e) Click Save.

The machine and its related Subscriber or Secondary machine are added to the System Inventory.
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What to do next

If you remove a component from your deployment, delete it from your System Inventory. If you add the
component again, or add more components, add those components to the System Inventory.

Install VMware Tools
To install or upgrade using VOS, for Cisco Unified Communications Manager:

1. Ensure that your virtual machine is powered on.

2. Right-click the VM menu. Select Guest > Install / Upgrade VMware tools

3. Choose the interactive tools update and press OK.

4. Open the console and log in at the command prompt.

5. Enter the command utils vmtools refresh and confirm.

The server automatically reboots twice.

6. After reboot, check the Summary tab for the VM to verify that the VMware Tools version is current. If
it is not current, reboot the VM and check the version again.

The process takes a few minutes. After the process is complete, the tools are listed as Running (Current) on
the VM's Summary tab in vSphere.

Configure an Identity Provider (IdP)
To support SSO for the contact center solution, configure an Identity Provider (IdP) that is compliant with
the Security Assertion Markup Language 2.0 (SAML v2) Oasis standard. The IdP stores user profiles and
provides authentication services to the contact center solution.

This section provides sample configuration information for Microsoft AD FS.

Follow this sequence of tasks to configure the Identity Provider.

TaskSequence

Install and Configure Active Directory Federation Services, on page 161

Set Authentication Type. See Authentication Types, on page 17.2

Enable Signed SAML Assertions, on page 194

Optionally Customize the AD FS Sign-In Page in Windows Server to Allow User ID, on
page 20

5

Install and Configure Active Directory Federation Services
Follow Microsoft instructions and guidelines to install Microsoft Active Directory Federation Services (AD
FS).

For example, seeActive Directory Federation Services Overview at https://technet.microsoft.com/en-us/library/
hh831502(v=ws.11).aspx
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• For AD FS 2.0, see AD FS Content Map at http://aka.ms/adfscontentmap.

• For AD FS in Windows Server, see AD FS Technical Reference at https://docs.microsoft.com/en-us/
windows-server/identity/active-directory-federation-services.

SSO for Unified CCE supports IdPs other than MS, and AD FS. For the list of supported IdPs see the
Compatibility matrix https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-device-support-tables-list.html

Note

The certificate trust between the IdP and the Cisco Identity Service (Cisco IdS) requires SHA-1. (Certificate
trust between Cisco IdS and the application browsers uses SHA-256.)

Note

Authentication Types
Cisco Identity Service supports form-based authentication of the Identity Provider.

For information on enabling form-based authentication in ADFS, see Microsoft documentation:

• For ADFS 2.0 see https://social.technet.microsoft.com/wiki/contents/articles/
1600.ad-fs-2-0-how-to-change-the-local-authentication-type.aspx

• For ADFS 3.0 see https://blogs.msdn.microsoft.com/josrod/2014/10/15/
enabled-forms-based-authentication-in-adfs-3-0/

For Kerberos authentication to work, ensure to disable the form-based authentication and follow the steps
provided in the sectionKerberos Authentication (IntegratedWindows Authentication) at https://www.cisco.com/
c/en/us/support/docs/customer-collaboration/unified-contact-center-express/
200612-Configure-the-Identity-Provider-for-UCCX.html#anc19.

In AD FS, be sure that the default Authentication Type is set to Forms.

Integrate Cisco IdS to the Shared Management AD FS

Procedure

Step 1 In AD FS, be sure that the default Authentication Type is set to Forms. (Cisco Identity Service requires the
Identity Provider to provide form-based authentication.) See the Microsoft AD FS documentation for details.

Step 2 In AD FS server, open AD FS Management.
Step 3 Right-click AD FS -> Trust Relationships -> Relying Party Trust.
Step 4 From the menu, choose Add Relying Party Trust to launch the Add Relying Party Trust Wizard.
Step 5 In the Select Data Source step, choose the option Import data about the relying party from a file.
Step 6 Browse to the sp.xml file that you downloaded from Cisco Identity Server and complete the import to

establish the relying party trust.
Step 7 Select the step Specify Display Name, and add a significant name you can use to identify the Relying Party

Trust.
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Step 8 For AD FS in Windows Server, select the option I do not want to configure multi-factor authentication
settings for the relying party at this time in the Step Configure Multi-factor Authentication Now.

This step does not appear in AD FS 2.0 or 2.1. Continue with the next step.

Step 9 In the Step Choose Issuance Authorization Rules, select the option Permit all users to access this relying
party and click Next.

Step 10 Click Next again to finish adding the relying party.
Step 11 Right-click on the Relying Party Trust and click Properties. Select the Identifiers tab.
Step 12 On the Identifiers tab, Set Display name to the name you specified when creating the Relying Party Trust,

and set theRelying party identifier to the fully qualified hostname of the Cisco Identity Server from which
sp.xml was downloaded.

Step 13 Still in Properties, select the Advanced tab.
Step 14 Select secure hash algorithm as SHA-1 and then click OK.

In the following steps, you configure two claim rules to specify the claims that are sent from AD
FS to Cisco Identity Service as part of a successful SAML assertion:

• A claim rule with the following custom claims, as AttributeStatements, in the assertion:

• uid - Identifies the authenticated user in the claim sent to the applications.

• user_principal - Identifies the authentication realm of the user in the assertion sent to
Cisco Identity Service.

• A second claim rule that is a NameID custom claim rule specifying the fully qualified domain
name of the AD FS server and the Cisco IdS server.

Note

Follow the steps to configure these rules.

Step 15 In Relying Party Trusts, right-click on the Relying Party Trust you created, and click Edit Claim Rules.
Step 16 Follow these steps to add a rule with Send LDAP Attributes as Claims as the Claim rule template.

a) In the Issuance Transform Rules tab, click Add Rule.
b) In the Step Choose Rule Type, select the claim rule template Send LDAP Attributes as Claims and

click Next.
c) In the Configure Claim Rule step, in the Claim rule name field, enter NameID.
d) Set the Attribute store drop-down to Active Directory.
e) Set the tableMapping of LDAP attributes to outgoing claim types to the appropriateLDAPAttributes

and the corresponding Outgoing Claim Type for the type of user identifier you are using:

• When the identifier is stored as a SAM-Account-Name attribute:

1. Select anLDAPAttributeof SAM-Account-Name, and set the correspondingOutgoingClaim
Type to uid (lowercase).

2. Select a secondLDAPAttribute ofUser-Principal-Name and set the correspondingOutgoing
Claim Type to user_principal (lowercase).

• When the identifier is a UPN:

1. Select anLDAPAttributeofUser-Principal-Name, and set the correspondingOutgoing Claim
Type to uid (lowercase).
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2. Select a secondLDAPAttribute ofUser-Principal-Name and set the correspondingOutgoing
Claim Type to user_principal (lowercase).

The SAM-Account-Name or UPN choice is based on the User ID configured in the AW.Note

Step 17 Follow these steps to add a second rule with the template custom claim rule.
a) Select Add Rule on the Edit Claim Rules window.
b) Select Send Claims Using Custom Rule.
c) Set the name of rule to the fully qualified domain name (FQDN) of the Cisco Identity Server publisher

(primary) node.
d) Add the following rule text:

c:[Type == "http://schemas.microsoft.com/ws/2008/06/identity/claims/windowsaccountname"]
=>
issue(Type = "http://schemas.xmlsoap.org/ws/2005/05/identity/claims/nameidentifier",
Issuer = c.Issuer, OriginalIssuer = c.OriginalIssuer, Value = c.Value, ValueType =
c.ValueType,
Properties["http://schemas.xmlsoap.org/ws/2005/05/identity/claimproperties/format"] =
"urn:oasis:names:tc:SAML:2.0:nameid-format:transient",

Properties["http://schemas.xmlsoap.org/ws/2005/05/identity/claimproperties/namequalifier"]
=
"http://<AD FS Server FQDN>/adfs/services/trust",

Properties["http://schemas.xmlsoap.org/ws/2005/05/identity/claimproperties/spnamequalifier"]
=
"<fully qualified domain name of Cisco IdS>");

e) Edit the script as follows:

• Replace <ADFS Server FQDN> to match exactly (including case) the ADFS server FQDN (fully
qualified domain name.)

• Replace <Cisco IdS server FQDN> to match exactly (including case) the Cisco Identity Server
FQDN.

Step 18 Click OK.

Enable Signed SAML Assertions
Enable Signed SAML Assertions for the Relying Party Trust (Cisco Identity Service).

Procedure

Step 1 Click Start and type powershell in the Search field to display the Windows Powershell icon.
Step 2 Right-click on the Windows Powershell program icon and select Run as administrator

All PowerShell commands in this procedure must be run in Administrator mode.Note

Step 3 Run the command, Set-ADFSRelyingPartyTrust -TargetName <Relying Party Trust Display Name>
-SamlResponseSignature "MessageAndAssertion".
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Set <Relying Party Trust Display Name> to exactly match (including case) the Identifier tab of the
Relying Party Trust properties.

Note

For example:

Set-ADFSRelyingPartyTrust -TargetName CUICPub.PCCERCDN.cisco.com
-SamlResponseSignature "MessageAndAssertion".

Step 4 Navigate back to the Cisco Identity Service Management window.
Step 5 Click Identity Service Settings.
Step 6 Click IdS Trust.
Step 7 On the Download SAML SP Metadata and Upload IdP Metadata windows, click Next as you have already

established trust relationship between IdP and IdS.
Step 8 Click Test SSO Setup.
Step 9 On the AD FS authentication window, provide the login credentials.
Step 10 On successful SSO setup, the message "SSO Configuration is tested successfully" is displayed.

If you receive the error message "An error occurred", ensure that the claim you created on the AD
FS is enabled.

If you receive the error message "IdP configuration error: SAML processing failed", ensure that the
rule has the correct names for Ids and AD FS.

Note

Optionally Customize the AD FS Sign-In Page in Windows Server to Allow User ID
By default, the sign-in page presented to SSO users by AD FS in Windows Server requires a username that
is a UPN. Usually this is an email format, for example, user@cisco.com. If your contact center solution is in
a single domain, you can modify the sign-in page to allow your users to provide a simple User ID that does
not include a domain name as part of the user name.

There are several methods you can use to customize the AD FS sign-in page. Look in the Microsoft AD FS
in Windows Server documentation for details and procedures to configure alternate login IDs and customize
the AD FS sign-in pages.

The following procedure is an example of one solution.

Procedure

Step 1 In the AD FS Relying Party Trust, change the NameID claim rule to map the chosen LDAP attribute to uid.
Step 2 Click the Windows Start control and type powershell in the Search field to display the Windows Powershell

icon.
Step 3 Right-click on the Windows Powershell program icon and select Run as administrator

All PowerShell commands in this procedure must be run in Administrator mode.

Step 4 To allow sign-ins to AD FS using the sAMAccountName, run the following Powershell command:

Set-AdfsClaimsProviderTrust -TargetIdentifier "AD AUTHORITY" -AlternateLoginID sAMAccountName

-LookupForests myDomain.com
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In the LookupForests parameter, replace myDomain.com with the forest DNS that your users belong to.

Step 5 Run the following commands to export a theme:

mkdir C:\themeExport-AdfsWebTheme –Name default –DirectoryPath c:\theme

Step 6 Edit onload.js in C:\theme\script and add the following code at the bottom of the file. This code changes
the theme so that the AD FS sign-in page does not require a domain name or an ampersand, "@", in the
username.
// Update the placeholder text to not include the domain
var userNameInput = document.getElementById("userNameInput");
if (userNameInput) {
userNameInput.setAttribute("placeholder", "Username");
}

// Override submitLoginRequest to not have the "@" check
Login.submitLoginRequest = function () {
var u = new InputUtil();
var e = new LoginErrors();
var userName = document.getElementById(Login.userNameInput);
var password = document.getElementById(Login.passwordInput);
if (!userName.value) {
u.setError(userName, e.userNameFormatError);
return false;
}
if (!password.value) {
u.setError(password, e.passwordEmpty);
return false;
}
document.forms['loginForm'].submit();
return false;
};

Step 7 In Windows PowerShell, run the following commands to update the theme and make it active:

Set-AdfsWebTheme -TargetName custom -AdditionalFileResource

@{Uri=’/adfs/portal/script/onload.js’;path="c:\theme\script\onload.js"}

Set-AdfsWebConfig -ActiveThemeName custom

Set up the System Inventory for Single Sign-On
Set up the System Inventory before configuring the Cisco Identity Service (Cisco IdS) and the components
for single sign-on.

By default, the System Inventory displays a list of all of the AWs, Routers, and Peripheral Gateways in the
deployment. Select the Principal AW to manage registering the components with the Cisco IdS and enabling
them for SSO. Add the remaining SSO-capable machines to the System Inventory, and select the default Cisco
IdS for each of the SSO-capable machines.

Procedure

Step 1 In Unified CCE Administration, navigate to System > Single Sign-On.
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Step 2 Set the Principal AW:
a) Click the AW that you want to be the Principal AW.

If the AW is coresident with the Router, you can set the Principal AW on the Router.

You can only specify one Principal AW for each Unified CCE system.

Note

The Edit AW popup window opens.
b) Check the Principal AW check box on the General tab.
c) Enter the Unified CCE Diagnostic Framework Service domain, username, and password.

These credentials must be for a domain user who is a member of the Config security group for the instance.
These credentials must be valid on all CCE components in your deployment (Routers, PGs, AWs, and so
on).

d) Click Save.

Step 3 Add the SSO-capable machines to the System Inventory:
a) Click New.

The Add Machine popup window opens.
b) From the Type drop-down list, select one of the following types of machines:

• Finesse Primary

• CUIC, LD, IdS Publisher, for the coresident Unified Intelligence Center, Live Data, and Cisco IdS
machine available in the 2000 agent or Progger (Lab only) reference design

• Unified Intelligence Center Publisher, if you are using a standalone Unified Intelligence Center

• Identity Service Primary, if you are using a standalone Cisco IdS

c) In the Hostname field, enter the FQDN, IP address, or hostname of the machine.

If you do not enter the FQDN, the system converts the value you enter to FQDN.Note

d) Enter the machine's Administration credentials.
e) Click Save.

The machine and its related Subscriber or Secondary machine are added to the System Inventory.
f) Repeat this procedure to add all of the SSO-capable machines in the deployment.

Step 4 Select the default Identity Service for each of the following machines:

• All Unified CCE AW servers

• Finesse Primary and Secondary

• Unified Intelligence Center Publisher and Subscriber
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If you are using a coresident CUIC, LD, Ids Publisher and Subscriber, you do not need to set the
default Cisco IdS for those machines.

In a standalone deployment, select the Cisco IdS that is deployed on the same Data Center Side (A
or B) as the machine you are configuring. For example, in the Reference Deployment:

• Select the Identity Service Publisher (IdS A) for AW-HDS-DDS 1, AW-HDS 3, Finesse 1 Pub,
Finesse 2 Pub, CUIC Pub, and CUIC Sub 1.

• Select the Identity Service Subscriber (Ids B) for AW-HDS-DDS 2, AW-HDS 4, Finesse 1
Sub, Finesse 2 Sub, CUIC Sub 2, and CUIC Sub 3.

For details on the Reference Deployment, see Solution Design Guide for Cisco Unified Contact
Center Enterprise at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-enterprise/products-implementation-design-guides-list.html.

Note

a) Click a machine to open the Edit Machine popup window.
b) Click the Search icon next toDefault Identity Service to open the Select Identity Service popup window.
c) Enter the machine name for the Cisco IdS in the Search field and choose the Cisco IdS from the list.
d) Click Save.

What to do next

Be sure to update the System Inventory if you change your deployment:

• If you add or remove contact center solution components from your deployment, make the corresponding
changes in the System Inventory.

• If you add or remove Cisco Identity Service machines or coresident CUIC-LD-IdS machines, update the
System Inventory appropriately and reconfigure the Cisco IdS. Re-associate the components with a
default Cisco IdS.

Reset Live Data Streaming Data Source After Upgrade and Migration
If you upgrade from Packaged CCE 11.0 to 11.5(1), and then switch from Packaged CCE to a Unified CCE:
4000 Agents Rogger deployment in which Unified Intelligence Center is installed coresident with Live Data
and Cisco IdS, you must reset the Live Data Streaming Data Source.

In this situation, when you set up the coresident machine in the system inventory, the system generates a new
username and password for the Live Data API service that does not match the existing credentials for the Live
Data Streaming Data Source. As a result, the Live Data Streaming Data Source is no longer online.

Perform the following procedure to reset the Live Data Streaming Data Source:

Procedure

• After you add the coresident CUIC, LD, IdS machine to the system inventory, access the Live Data CLI
and run the following command:

set live-data cuic-datasource
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For more information about Live Data CLI, see the Live Data CLI Commands section of the Cisco Unified
Contact Center Enterprise Installation and Upgrade Guide at https://www.cisco.com/c/en/us/support/
customer-collaboration/unified-contact-center-enterprise/products-installation-guides-list.html.

Note

Configure the Cisco Identity Service
The Cisco Identity Service (Cisco IdS) provides authorization between the Identity Provider (IdP) and
applications.

When you configure the Cisco IdS, you set up a metadata exchange between the Cisco IdS and the IdP. This
exchange establishes a trust relationship that then allows applications to use the Cisco IdS for single sign-on.
You establish the trust relationship by downloading a metadata file from the Cisco IdS and uploading it to
the IdP. You can then select settings related to security, identify clients of the Cisco IdS service, and set log
levels and, if desired, enable Syslog format.

If you are working with a Cisco IdS cluster, perform these steps on the Cisco IdS primary publisher node.

Be sure that the Principal AW is configured and functional before using the System > Single Sign-On tool
in Unified CCE Administration.

Note

Procedure

Step 1 In Unified CCE Administration, navigate to System > Single Sign-On.

Use a log in name in the format username@FQDN to log in to the Unified CCE Administration.Note

Step 2 Click Identity Service Management.

The Cisco Identity Service Management window opens:

https://<Cisco IdS server address>:8553/idsadmin

Step 3 Enter your user name, and then click Next.
Step 4 Enter your password, and then click Sign In.

The Cisco Identity Service Management page opens, showing the Nodes, Settings, and Clients icons in the
left pane.

Step 5 Click Nodes.
TheNodes page opens to the overall Node level view and identifies which nodes are in service. The page also
provides the SAMLCertificate Expiry details for each node, indicating when the certificate is due to expire.
The node Status options areNot Configured, In Service, Partial Service, andOut of Service. Click a status
to see more information. The star to the right of one of the Node names identifies the node that is the primary
publisher.

Step 6 Click Settings.
Step 7 Click IdS Trust.
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Step 8 To begin the Cisco IdS trust relationship setup between the Cisco IdS and the IdP, clickDownloadMetadata
File to download the file from the Cisco IdS Server.

Step 9 Click Next.
Step 10 To upload the trusted metadata file from your IdP, browse to locate the file.

The Upload IdP Metadata page opens and includes the path to the IdP. When the file upload finishes, you
receive a notification message. The metadata exchange is now complete, and the trust relationship is in place.

Step 11 Click Next.
The Test SSO Setup page opens.

Step 12 Click Test SSO Setup.
A message appears telling you that the Cisco IdS configuration has succeeded.

Step 13 Click Settings.
Step 14 Click Security.
Step 15 Click Tokens.

Enter the duration for the following settings:

• Refresh Token Expiry -- The default value is 10 hours. The minimum value is 2 hours. The maximum
is 24 hours.

• Authorization Code Expiry -- The default value is 1 minute, which is also the minimum. Themaximum
is 10 minutes.

• Access Token Expiry -- The default value is 60minutes. Theminimum value is 5 minutes. Themaximum
is 120 minutes.

Step 16 Set the Encrypt Token (optional); the default setting is On.
Step 17 Click Save.
Step 18 Click Keys and Certificates.

The Generate Keys and SAML Certificate page opens and allows you to:

• Regenerate the Encryption/Signature key by clicking Regenerate. A message appears to say that the
Token Registration is successful and advises you to restart the system to complete the configuration.

• Regenerate the SAML Certificate by clicking Regenerate. A message appears to say that the SAML
certificate regeneration is successful.

Step 19 Click Save.
Step 20 Click Clients.

The Clients page identifies the existing Cisco IdS clients, providing the client name, the client ID, and a
redirect URL. To search for a particular client, click the Search icon above the list of names and type the
client's name.

Step 21 To add a client:
a) Click Add Client.
b) Enter the client's name.
c) Enter the Redirect URL. To add more than one URL, click the plus icon.
d) Click Add (or click Clear and then click the X to close the page without adding the client).

Step 22 To edit or delete a client, highlight the client row and click the ellipses under Actions. Then:

• Click Edit to edit the client's name, ID, or redirect URL. On the Edit Client page, make changes and
click Save (or click Clear and then click the X to close the page without saving edits).
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• Click Delete to delete the client.

Step 23 Click Settings.
Step 24 From the Settings page, click Troubleshooting to perform some optional troubleshooting.
Step 25 Set the local log level by choosing from Error,Warning, Info (the default), Debug, or Trace.
Step 26 To receive errors in Syslog format, enter the name of the Remote Syslog Server in the Host (Optional) field.
Step 27 Click Save.

You can now:

• Register components with the Cisco IdS.

• Enable (or disable) SSO for the entire deployment.

Related Topics
Configure the Identity Provider in Your Environment
Register Components and Set Single Sign-On Mode, on page 26

Register Components and Set Single Sign-On Mode
If you add any SSO-compatible machines to the System Inventory after you register components with the
Cisco IdS, those machines are registered automatically.

Before you begin

• Configure the Cisco Identity Service (Cisco IdS).

• Disable popup blockers. It enables viewing all test results correctly.

• If you are using Internet Explorer, verify that:

• It is not in the Compatibility Mode.

• You are using the fully qualified domain name of AW to access the CCE Administration (for
example, https://<FQDN>/cceadmin).

Procedure

Step 1 In the Unified CCE Administration, navigate to System > Single Sign-On.
Step 2 Click the Register button to register all SSO-compatible components with the Cisco IdS.

The component status table displays the registration status of each component.

If a component fails to register, correct the error and click Retry.

Step 3 Click the Test button. When the new browser tab opens, you may be prompted to accept a certificate. In order
for the page to load, accept any certificates. Then, when presented with a log in dialog, log in as a user with
SSO credentials.
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The test process verifies that each component has been configured correctly to reach the Identity Provider,
and that the Cisco IdS successfully generates access tokens. Each component that you are setting up for SSO
is tested.

The component status table displays the status of testing each component.

If a test is unsuccessful, correct the error, and then click Test again.

Test results are not saved. If you refresh the page, run the test again before enabling SSO.

Step 4 Select the SSO mode for the system from the Set Mode drop-down menu:

• Non-SSO: This mode disables SSO for all agents and supervisors. Users log in using existing Active
Directory-based local authentication.

• Hybrid: This mode allows you to enable agents and supervisors selectively for SSO.

• SSO: This mode enables SSO for all agents and supervisors.

The component status table displays the status of setting the SSO mode on each component.

If the SSO mode fails to be set on a component, correct the error, and then select the mode again.

Migration Considerations Before Enabling Single Sign-On

Administrator User and Single Sign-On in Unified Intelligence Center
During installation, Cisco Unified Intelligence Center creates an administrator user. This user is not enabled
for SSO, as the user is known only to Unified Intelligence Center.

When you enable SSO, this administrator user is no longer able to log in to the Unified Intelligence Center
and perform administrative tasks. These tasks include configuring datasources and setting permissions for
other users, for example. To avoid this situation, perform the following steps before enabling SSO.

1. Create a new SSO user who has the same roles and permissions as those of the administrator user.

2. Log in to the CLI.

3. Run the following command:

utils cuic user make-admin username

in which the user name is the complete name of the new user, including the authenticator prefix as shown on
the Unified Intelligence Center User List page.

The command, when executed, provides all the roles to the new user and copies all permissions from the
administrator user to this new user.
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• The administrator's group memberships are not copied to the new user by this CLI command and must
be manually updated. The new user, now a Security Administrator, can set up the group memberships.

• For any entity (for example, reports or report definitions), if this new user’s permissions provide higher
privileges than the administrator, the privileges are left intact. The privileges are not overwritten by the
execution of this CLI command.

Note

Browser Settings and Single Sign-On
If you have enabled single sign-on and are using Chrome or Firefox, verify that the browser options are set
as shown in the following table. These settings specify that you do not want a new session of the browser to
reopen tabs from a previous session. No changes are required for Internet Explorer.

Browser options to verify when using SSOBrowser

1. Open a Chrome browser session.

2. Click the Customize and control Google
Chrome icon.

3. Click Settings.

4. In the On startup section of the Settings page,
verify that the Open the New Tab page option
is selected.

Chrome

1. Open a Firefox browser session.

2. Click the Open menu icon.

3. Click Options.

4. In the Startup section of theGeneral page, verify
that either the home page or a blank page is
chosen in theWhen Firefox starts drop-down
list.

Firefox
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Migrate Agents and Supervisors to Single Sign-On Accounts

Be aware that this release does not provide support for disabling SSO once it is enabled.

Customers electing global hybrid mode to incrementally add SSO-enabled users may subsequently move to
global enablement, or global enablement may be configured directly. However, the transition of hybrid mode
to global off, of per-agent disablement while in hybrid mode, or of switching global on to global off is not
supported at this time.

Customers who attempt to disable SSO after enabling it may experience user account inconsistencies, such
as cleared (pre-SSO) passwords, invalid passwords, and Cisco Unified Intelligence Center reporting issues
for supervisor accounts introduced after SSOwas enabled. For this reason, be sure to back up Logger databases
using the Microsoft SQL Server Backup and Restore utility.

Contact the Cisco TAC for questions or assistance.

Important

If you are enabling SSO in an existing deployment, you can set the SSO state to hybrid to support a mix of
SSO and non-SSO users. In hybrid mode, you can enable agents and supervisors selectively for SSO making
it possible for you to transition your system to SSO in phases.

Use the procedures in this section to migrate groups of agents and supervisors to SSO accounts using the SSO
Migration content file in the Unified CCE Administration Bulk Jobs tool. You use the Administration Bulk
Jobs tool to download a content file containing records for agents and supervisors who have not migrated to
SSO accounts. You modify the content file locally to specify SSO usernames for the existing agents and
supervisors. Using the Administration Bulk Jobs tool again, you upload the content file to update the agents
and supervisors usernames; the users are also automatically enabled for SSO.

The content file returns the first 12,000 agents and supervisors who have not been migrated to SSO accounts.
After you run the bulk job to update users from that group of records, you can download the SSO Migration
content file again to update additional agent and supervisor records.

If you do not want to migrate a user, delete the row for that user.

For instructions on how to setup SSO for Agent or Supervisor login, see the Configure the Cisco Identity
Service, on page 24.

While the Finesse agent is logged in, changing the login name prevents the agent from answering or placing
calls. In this situation, the agent can still change between ready and not_ready state. This affects all active
agents, independent of whether SSO is enabled or disabled. Should you need to modify a login name, do so
only after the corresponding agent is logged out. Note too that SSO migration (moving a non-SSO agent to
be SSO-enabled, by either hybrid mode or global SSO mode) should not be done when the agent is logged
in.

Important

Procedure

Step 1 In Unified CCE Administration, navigate toManage > Bulk Jobs.
Step 2 Download the SSO Migration bulk job content file.
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a) Click Templates.

The Download Templates popup window opens.

b) Click the Download icon for the SSO Migration template.
c) Click OK to close the Download Templates popup window.

Step 3 Enter the SSO usernames in the SSO Migration content file.
a) Open the template in Microsoft Excel. Update the newUserName field for the agents and supervisors

whom you want to migrate to SSO accounts.

The content file for the SSO migration bulk job contains these fields:

DescriptionRequired?Field

The user's non-SSO username.YesuserName

The user's first name.NofirstName

The user's last name.NolastName

The user's new SSO username. Enter up to 255 ASCII characters.

If you want to enable a user for SSO, but keep the current username,
leave newUserName blank, or copy the value of userName into
newUserName.

NonewUserName

b) Save the populated file locally.

Step 4 Create a bulk job to update the usernames in the database.
a) Click New to open the New Bulk Job window.
b) Enter an optional Description for the job.
c) In the Content File field, browse to the SSO Migration content file you completed.

The content file is validated before the bulk job is created.

d) Click Save.

The new bulk job appears in the list of bulk jobs. Optionally, click the bulk job to review the details and
status for the bulk job. You can also download the log file for a bulk job.

When the bulk job completes, the agents and supervisors are enabled for SSO and their usernames are
updated. You can open an individual user's record to see the changes.

Step 5 Repeat this procedure, if needed, to migrate additional agents and supervisors to SSO usernames.

What to do next

After all of the agents and supervisors in your deployment are migrated to SSO accounts, you can enable SSO
globally in your deployment.
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Single Sign-On Migration and the Configuration Manager
When the global SSO-enabled setting is Hybrid, you can use several of the existing Unified CCEConfiguration
Manager tools to either:

• Enable (or disable) users individually for single sign-on

• Prevent changes to system configuration information access

New functionality specific to
single sign-on

General descriptionTool

Includes an Enable single sign-on
(SSO) option. Check the check box
to require a selected agent to sign
in with SSO authentication.
Uncheck the check box to require
Unified CCE authentication.

The check box is
disabledwhen the global
SSO-enabled setting is
enabled or disabled.

Note

Allows you to view, and (if you
have maintenance privileges)
define, delete, or edit agent records,
routes, peripheral targets, labels,
and their relationships. You can
also designate an agent as a
supervisor.

Agent Explorer (in Explorer Tools)

Allows you to view or change the
person's SSO status. If the global
SSO setting is hybrid, the person's
SSO enabled setting is either:

• Yes if the person uses SSO
authentication

• No if the person uses non-SSO
authentication.

(If global SSO is enabled, the
person's SSO setting is ignored. All
agents use SSO authentication.

If global SSO is disabled, the
person's SSO setting is ignored. All
agents use non-SSO
authentication.)

In Import or Export
files, the Person SSO
Enabled setting is
recorded in the file as a
number: Yes = 1, No =
0.

Note

Allow you to insert and update
multiple configuration records in a
single transaction from a single
screen.

Person Bulk Insert and Person Bulk
Edit (in Bulk Configuration Tools)
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New functionality specific to
single sign-on

General descriptionTool

Includes an Enable single sign-on
(SSO) option. Check the check box
to require an agent associated with
a selected Person to sign in with
SSO authentication. Uncheck the
check box to require Unified CCE
authentication.

The check box is
disabledwhen the global
SSO-enabled setting is
enabled or disabled.

Note

Allows you to list the persons
currently defined in the database,
to define new persons, and to view,
edit, or delete the records of
existing persons.

Person List (in List Tools)

Prevents changes to Configuration
Security Group membership or
system information read-only
access for SSO-enabled
supervisors.

Allows you to list the users
currently defined, associate new
users with their Active Directory
account, and view, edit, or delete
the records of existing
(nonsupervisor) users.

User List (in List Tools)

For more information, see the Explorer Tools online help, the Bulk Configuration Tools online help, or the
List Tools online help.

Related Documentation
Refer to the following documents and other resources for more details about single sign-on.

For these detailsLocated hereSee this information

Design considerations and
guidelines for deploying the
Cisco Unified CCE System.

https://www.cisco.com/c/en/us/support/
customer-collaboration/
unified-contact-center-enterprise/
products-implementation-design-guides-list.html

Solution Design Guide for
Cisco Unified Contact Center
Enterprise

How to monitor and manage
Unified Contact Center
Enterprise (Unified CCE) and
Cisco Unified Intelligent
Contact Management
Enterprise (Unified ICM).

https://www.cisco.com/c/en/us/support/
customer-collaboration/
unified-contact-center-enterprise/
products-installation-and-configuration-guides-list.html

Serviceability Guide for Cisco
Unified ICM/Contact Center
Enterprise

New features and changes for
this release of the Unified
CCE solution.

https://www.cisco.com/c/en/us/support/
customer-collaboration/
unified-contact-center-enterprise/
products-release-notes-list.html

Release Notes for Cisco
Unified Contact Center
Enterprise Solutions
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For these detailsLocated hereSee this information

Information about deploying
Unified CCE (including single
sign-on) on VMware.

https://www.cisco.com/c/dam/en/us/td/docs/
voice_ip_comm/uc_system/virtualization/
virtualization-unified-contact-center-enterprise.html

Virtualization for Unified
Contact Center Enterprise

Unified CCE requirements.https://www.cisco.com/c/en/us/support/
customer-collaboration/
unified-contact-center-enterprise/
products-device-support-tables-list.html

Unified CCE Solution
Compatibility Matrix

Changes to support single
sign-on.

Online helpConfiguration Manager:

• Explorer Tools

• List Tools

Changes to support single
sign-on.

Online helpUnified CCE Administration
Single Sign-On Tool

Information related to adding
SSO-compatible components
to the inventory.

This guide.System Inventory Tool
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